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REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.
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Asia-Pacific Forum 
Pacific Rim Assoc.
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This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.
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John Smith 
Secretary
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Relations sponsored by Asia-Pacific 
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Asia-Pacific Forum 
Pacific Rim Assoc.
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Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.
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Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2013


Agency Contact: Stephen Harms


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              
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BENEFIT SOURCE
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BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


stephen.l.harms.civ@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK
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IN-KIND
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3
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AMOUNT
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MM/DD/YYYY]


X X


REPORTING 
PERIOD: 


OCTOBER 1, 
2012- MARCH 


31, 2013


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2013





		Instruction Sheet
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		RENAME BLANK FORM
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This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.
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Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








PAGE OF PAGES YEAR


1 5 2018


Agency Contact: Beverlee E. Forbes


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]


McPhail, Michael World Cup Korea 4/3/2018 Changwon, Korea Transportation x 1,500.00$       


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


SFC USA Shooting 4/29/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Norton, George World Cup Korea 4/3/2018 Changwon, Korea Transportation x 1,500.00$       


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


SFC USA Shooting 4/29/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Eller, Walton World Cup Korea 4/3/2018 Changwon, Korea Transportation x 1,500.00$       


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


SFC USA Shooting 4/29/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Haldeman, Derek World Cup Korea 4/3/2018 Changwon, Korea Transportation x 1,500.00$       


4


LOCATION BENEFIT SOURCE


USA Shooting


3


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


REPORTING 


PERIOD: APRIL 1, 


2018-


SEPTEMBER 30, 


2018


2


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


1


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


NEGATIVE 


REPORTU.S. Army Marksmanship Unit (USAMU)
 beverlee.e.forbes.civ@mail.mil


OGE Form-1353


(OGE-Approved Alternative for SF-326)


February 2011


1353 Travel Report for ARMY, U.S. Army Marketing & Engagement Brigade (USAMEB) for the reporting period April 1, 2018 - September 30, 2018.


No.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For 


definitions and policies, see 41 CFR part 304-1.


ARMY


PAYMENT 


BY CHECK


PAYMENT 


IN-KIND


TOTAL 


AMOUNT


BENEFIT 


DESCRIPTION
TRAVELER 


EVENT DESCRIPTION & 


EVENT SPONSOR


EVENT DATE(S) 


[MM/DD/YYYY-


MM/DD/YYYY]:


LOCATION AND 


TRAVEL DATE(S) 


[MM/DD/YYYY-


MM/DD/YYYY]


BENEFIT SOURCE


REPORTING 


PERIOD: 


OCTOBER 1, 


2017-MARCH 31, 


2018


X







TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


SSG USA Shooting 4/29/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Taylor, Dustan World Cup Korea 4/3/2018 Changwon, Korea Transportation x 1,500.00$       


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


SGT USA Shooting 4/29/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Elliott, Christian World Cup Korea 4/3/2018 Changwon, Korea Transportation x 1,500.00$       


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


SPC USA Shooting 4/29/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Jungman, Phillip World Cup Korea 5/1/2018 Changwon, Korea Transportation x 1,500.00$       


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x 1,000.00$       


PFC USA Shooting 5/12/2018
04/02/2018 - 


04/30/2018
Entry Fees x 250.00$          


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Tichenor, Shaun 5/1/2018 Cheongju, Korea Transportation x  $          850.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,950.00 


SFC USA Shooting 5/12/2018
04/29/2018 - 


05/13/2018
Entry Fees x  $            40.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Joss, John 5/1/2018 Cheongju, Korea Transportation x  $          850.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,950.00 


SSG USA Shooting 5/12/2018
04/29/2018 - 


05/13/2018
Entry Fees x  $            40.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Nguyen, Kevin 5/1/2018 Cheongju, Korea Transportation x  $          850.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,950.00 


SSG USA Shooting 5/12/2018
04/29/2018 - 


05/13/2018
Entry Fees x  $            40.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


11


LOCATION BENEFIT SOURCE


10


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


9


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


8


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


7


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


6


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


5


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


4
TRAVEL DATE(S)







Stith, Emily Training Camp 5/16/2018 Colorado Springs Transportation x  $          500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $          200.00 


PV 2 USA Shooting 5/20/2018
05/16/2018 - 


05/20/2018
Entry Fees x  $          100.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


McPhail, Michael World Cup Munich 5/22/2018 Munich Germany Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SFC USA Shooting 5/29/2018
05/20/2018 - 


05/29/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Eller, Walton World Cup Malta 6/2/2018 Malta Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SFC USA Shooting 6/15/2018
06/02/2018 - 


06/15/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Jungman, Phillip World Cup Malta 6/2/2018 Malta Lodging/meals x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Transportation x  $       1,000.00 


PFC USA Shooting 6/15/2018
06/02/2018 - 


06/15/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


English, Amber World Cup Malta 6/2/2018 Malta Lodging/meals x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Transportation x  $       1,000.00 


2 LT USA Shooting 6/15/2018
06/02/2018 - 


06/15/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Stith, Emily World Cup Suhl 6/22/2018 Suhl Germany Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


PV2 USA Shooting 6/29/2018
06/20/2018 - 


06/29/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Eller, Walton World Cup Tucson AZ 7/9/2018 Tucson, AZ Transportation X  $          800.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals X  $       1,000.00 


SFC USA Shooting 7/19/2018
07/09/2018 - 


07/19/2018
Entry Fees X  $          250.00 


17


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


16


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


15


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


14


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


13


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


12


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


11
USA Shooting


TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Jungman, Phillip World Cup Tucson AZ 7/9/2018 Tucson, AZ Transportation X  $          800.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals X  $       1,000.00 


PFC USA Shooting 7/19/2018
07/09/2018 - 


07/19/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


English, Amber World Cup Tucson AZ 7/9/2018 Tucson, AZ Transportation X  $          800.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals X  $       1,000.00 


2 LT USA Shooting 7/19/2018
07/09/2018 - 


07/19/2018
Entry Fees X  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Gray, Henry World Championships 8/30/2018 Changwon, Korea Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SFC USA Shooting 9/15/2018
08/30/2018 - 


09/15/2018
Entry Fees x  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Eller, Walton World Championships 8/30/2018 Changwon, Korea Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SFC USA Shooting 9/15/2018
08/30/2018 - 


09/15/2018
Entry Fees x  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Jungman, Phillip World Championships 8/30/2018 Changwon, Korea Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


PFC USA Shooting 9/15/2018
08/30/2018 - 


09/15/2018
Entry Fees x  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Stith, Emily World Championships 8/30/2018 Changwon, Korea Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $          800.00 


PFC USA Shooting 9/8/2018
08/30/2018 - 


09/08/2018
Entry Fees x  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


English, Amber World Championships 8/30/2018 Changwon, Korea Transportation x  $       1,500.00 


24


LOCATION BENEFIT SOURCE


USA Shooting


23


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


22


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


21


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


20


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


19


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


18


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)







TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


2 LT USA Shooting 9/15/2018
08/30/2018 - 


09/15/2018
Entry Fees x  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


McPhail, Michael World Championships 8/30/2018 Changwon, Korea Transportation x  $       1,500.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SFC USA Shooting 9/12/2018
08/30/2018 - 


09/12/2018
Entry Fees x  $          250.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Joss, John World Cup France 9/22/2018 Chateauroux, FRA Transportation x  $       1,000.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SSG USA Shooting 9/30/2018 9/22/2018-9/30/2018 Entry Fees x  $          200.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Nguyen, Kevin World Cup France 9/22/2018 Chateauroux, FRA Transportation x  $       1,000.00 


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]
Lodging/meals x  $       1,000.00 


SSG USA Shooting 9/30/2018 9/22/2018-9/30/2018 Entry Fees x  $          200.00 


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


31


LOCATION BENEFIT SOURCE


30


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


29


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


28


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


27


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


26


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


25


LOCATION BENEFIT SOURCE


USA Shooting


TRAVEL DATE(S)


24
TRAVEL DATE(S)







TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


Lorraine, France


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


38


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


37


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


36


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


35


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


34


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


33


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


32


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


31
TRAVEL DATE(S)







TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION
BEGINNING DATE 


[MM/DD/YYYY]
                              


TRAVELER TITLE EVENT SPONSOR
ENDING DATE 


[MM/DD/YYYY]


45


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


44


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


43


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)


42


LOCATION BENEFIT SOURCE


TRAVEL DATE(S)
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SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 








PAGE OF PAGES YEAR


1 1 2018


Agency Contact: Ms. Courtney 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE                               


Patrick Bell 3rd Cyber Security 
Symposium 5/29/2018 Oslo, Norway Hotel x $359.26


TRAVELER TITLE EVENT SPONSOR ENDING DATE transportation x $818.96


Research Scientist Norwegian University of 
Technology 29 May 2018 27, 30 May 2018 Meals x $179.68


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE                               
Elie Alhajjar


 p  
Lattice Polytopes 7/23/2018 Osaka, Japan hotel (14 nights) x $960


TRAVELER TITLE EVENT SPONSOR ENDING DATE 


Assistant Professor Osaka University 08/03/2018 20 July, 4 August 
2018


TRAVEL DATE(S)


LOCATION


Asia Pacific Forum Pacific 
Rim Foundation 


BENEFIT SOURCE


BENEFIT SOURCE


OGE Form-1353
(OGE-Approved Alternative for SF-326)


February 2011


#ERROR!


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


United States Military Academy


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


ARMY CYBER INSTITUTE
courtney.gordon-


NEGATIVE 
REPORT


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
IN-KIND


TOTAL 
AMOUNT


REPORTING 
PERIOD: 1 Apr 


2018-30 Sep 
2018


BENEFIT SOURCETRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR


Osaka University


Norwegian University of 
Technology


BENEFIT SOURCELOCATION


TRAVEL DATE(S)


X


PAYMENT 
BY CHECK


REPORTING 
PERIOD: 1 Apr 


2018-30 Sep 
2018


BENEFIT 
DESCRIPTION


1


2


EX


LOCATION


TRAVEL DATE(S)
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2 2 2018


Agency Contact:
MAJ Matthew 
Gallagher


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Desmond Young Johnson and Johnson 
Internship AIAD 7/22/2018 New Brunswick, NJ Hotel X $4,043.33 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Cadet Johnson and Johnson 8/11/2018 07/22/2018-
08/11/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Kevin Hong Walmart Leadership AIAD 5/29/2018 Bentonville, AR Hotel X $1,470 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation Air X $500 


Cadet Walmart 5/29/2018 05/27/2018-
06/15/2018


Transportation 
Rental Car X $500 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Brandon Johnson Walmart Leadership AIAD 5/29/2018 Bentonville, AR Hotel X $1,470 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation Air X $500 


Cadet Walmart 5/29/2018 05/27/2018-
06/15/2018


Transportation 
Rental Car X $500 


EX


TRAVEL DATE(S)


LOCATION


Asia Pacific Forum 
Pacific Rim Foundation 


2


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018(845)938-8570


BENEFIT 
DESCRIPTION


United States Military Academy 
West Point


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


3


LOCATION


TRAVEL DATE(S)


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE TOTAL 
AMOUNT


NEGATIVE 
REPORT


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


BENEFIT SOURCE


Johnson and Johnson


BENEFIT SOURCE


Walmart


BENEFIT SOURCE


Walmart


BENEFIT SOURCE
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1 2 2018


Agency Contact: MAJ Gallagher


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Joseph Hanus


National Council of 
Examiners for Engineering 
and Surveying (NCEES) 
Committee Meeting


4/6/2018 Clemson, SC Hotel X $252 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X X $590.10 


COL NCEES 4/7/2018 04/05/2018-
04/07/2018 Meals X X $273.28 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Aaron Freidenberg Annual Steel Conference 4/17/2018 Baltimore, MD Transportation X $300 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Assistant Professor American Institute of Steel 
Construction 4/18/2018 04/17/2018-


04/18/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Timothy Guden WP Korea Founders Day 4/7/2018 Yongsan, Korea Hotel X $405 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $70 


CSM WP Society of Korea 4/7/2018 04/05/2018-
04/08/2018                            


BENEFIT SOURCE


NCEES


BENEFIT SOURCE


American Institute if Steel 
Construction


BENEFIT SOURCE


WP Society of Korea


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


(845)938-8570


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


United States Military Academy
West Point OSJA


NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018





		ACI 1 Apr 18 - 30 Sep 18

		USMA 1 Apr 18 - 30 Sep 18 Pg 2

		 USMA 1 Apr 18 - 30 Sep 18 Pg 1






SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE 


1 
OFPAGES 


This report Implements 31 U.S.C. 1353. lt does not supersede other reports that may have to ba filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1. 
REPORTING DEPARTMENT OR AGENCY 


Headquarters, U.S. Army Materiel Command 
TRAVELER EVENT 
(Namemtle) DESCRIPTIONISPONSOR/ DATES 


John Smith Conference on Asia-Pacific 
U) Relations sponsored by Asia-Pacific w Secretary ..J Forum. a.


� •••• ..... ••••"-•...,..••••••H-l••••••l++t••••p.++,oooP•rr.,. ... •••rru••••••••• nu♦u♦1♦010000000,ooo,,o,o,,ooou♦,,uo,,,, ....... , •• ,,.,o,,,,,,,,,,,, 


� Joyce Smith Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretaiy 
Forum. 


NAME DESCRIPTION 
Ms. Penny Pietrowski 


American Industrial Hygiene 
Conference and Exposition 


TITLE SPONSOR 
American Industrial Hygiene 


Industrial Hygienist Association 
OATES: 19-25 May 2018 


NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 (Year) 
I 1-;


RIL 1 - SEPTEMBER 10 (Year) I I NEGATIVE REPORT 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ......... ,,.,u.,, .................................. 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 


American Industrial 
Philadelphia, PA Hygiene Conference and 
OATES Exposition 


19-25 May 2018
LOCATION 


OATES 


LOCATION 


DATES 


LOCATION 


OATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X .. ............... ..120 ................................ ,u •••• ••u••u••••• ········•····•· 


Air Transportation X X $825 
Meals 


120 


Registration Fee X 1,284.00 


STANDARD FORM 326 (2-98)


Prescribed by GSNOGE (41 CFR 3D1-1) 


13







2 13











4 13











6 13











8 13











10 13











12 13







TRAVELER EVENT LOCATION AND BENEFITS ACCEPTED 
(Namefl'ltle) DESCRIPTION/SPONSOR/DATES TRAVEL DATES SOURCE DESCRIPTION CHECK IN-KIND AMOUNT 


NAME DESCRIPTION LOCATION 50% Reduction in 
X 21st International Chemical Conference Fee 346.00 


Weapons Demilitarization 
Kris Perkins Conference London, U.K. 
TITLE SPONSOR OATES 


Defense Science and Technology 
Laboratory (DSTL) 


Program Manager, ECBC OATES: 23-25 MAY 18 23-25 MAY 18 DSTL 
NAME DESCRIPTION LOCATION Course Fee & 


Meals X 690.00 
Institute of Food Technologists 


X Michelle Richardson (IFT) Annual meeting Chicago, IL Transportation 648.92 
TITLE SPONSOR DATES 


Institute of Food Technologists Institute of Food 
Senior Food Technologist, NSRDEC (IFT) Technologists (IFT) 


OATES: 15-18 JUL 18 15-18 JUL 18
NAME DESCRIPTION LOCATION 


TITLE SPONSOR OATES 


OATES: 


NAME DESCRIPTION LOCATION 


TITLE SPONSOR OATES 


DATES: 


NAME DESCRIPTION LOCATION 


TITLE SPONSOR DATES 


-


DATES: 


STANDARD FORM 326 (2-98) 












Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2018


Agency Contact: LTC James P. Leary


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Robert Brown Australia Senior Leader 
Engagement 5/5/2018 Canberra, Australia Foreign MILAIR 


Flight X $877 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $826 


Commanding General, 
US Army Pacific Government of Australia 5/9/2018 05/05/2018 - 


05/09/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Patricia Brown Australia Senior Leader 
Engagement 5/6/2018 Canberra, Australia Foreign MILAIR 


Flight X $877 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Spouse of 
Commanding General, 
US Army Pacific


Government of Australia 5/9/2018 05/05/2018 - 
05/09/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Dale Marrou Australia Senior Leader 
Engagement 5/6/2018 Canberra, Australia Foreign MILAIR 


Flight X $877 


BENEFIT SOURCE


Government of Australia


BENEFIT SOURCE


Government of Australia


BENEFIT SOURCE


Government of Australia


BENEFIT SOURCE


OGE Form-1353
(OGE-Approved Alternative for SF-326)


February 2011


1353 Travel Report for HEADQUARTERS, DEPT OF THE ARMY, US ARMY PACIFIC for the reporting period APRIL 1 - SEPTEMBER 30, 2018


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


james.p.leary4.mil@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


HEADQUARTERS, DEPT OF THE ARMY
US ARMY PACIFIC NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018







 


TRAVELER 


No.


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $826 


Aide-de-Camp, CG US 
Army Pacific Government of Australia 5/9/2018 05/05/2018 - 


05/09/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Robert Brown


Chief of Army Land 
Forces Seminar and 
Trilateral Senior Leader 
Seminar


9/3/2018 Adelaide, Australia Foreign MILAIR 
Flight X $88.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals x $875.00 


Commanding General, 
US Army Pacific Government of Australia 9/7/2018 09/03/2018 - 


09/07/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Patricia Brown


Chief of Army Land 
Forces Seminar and 
Trilateral Senior Leader 
Seminar


9/3/2018 Adelaide, Australia Meals x $645.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


Spouse of 
Commanding General, 
US Army Pacific


Government of Australia 9/7/2018 09/03/2018 - 
09/07/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


                           


BENEFIT SOURCE


Government of Australia


BENEFIT SOURCE


Government of Australia


BENEFIT SOURCE


TRAVEL DATE(S)


5


6


LOCATION


TRAVEL DATE(S)


LOCATION


TRAVEL DATE(S)


3
TRAVEL DATE(S)


4


LOCATION





		Instruction Sheet

		Agency Acronym

		USARPAC






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov
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1 1 2018


Agency Contact:
Melissa Dasgupta 
Smith


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Michael Hardy Special Operations Fund 
Seminar 4/29/2018 Washington, DC Hotel X $304 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $659 


Command Chief 
Warrant Officer Special Operations Fund 4/30/2018 4/29/2018 -4/30/2018 Meals X $200 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Ian McConnell
Official Speaker at Yale 
University Capstone 
Seminar


9/5/2018 New Haven, CT Air Transportation X $550.00 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] HOTEL X $125.00 


3rd SFG(A)
Yale University Jackson 
Institute of Global Affairs 
Policy


9/5/2018 09/04/2018 - 
09/05/2018


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sean Macrae Special Operations Fund 
Conference 4/30/2018 Washington, DC Hotel X $259 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $96 


LTC, USASOC Special Operations Fund 
Charity Event 4/30/2018 4/29/2018-05/01/2018                            


BENEFIT SOURCE


Special Operations Fund 


BENEFIT SOURCE


Yale University


BENEFIT SOURCE


Special Operations Fund 


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


melissa.dasguptasmith@socom.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


Department of the Army-- Department of Defense
ARMY NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018
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